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Use EndNote to:

e Create a library of all your references
e Attach PDFs and other files to your references

e Insert your references into Microsoft Word or Apple Pages documents, and into
Word Online and Google Docs with EndNote Web

e Automatically format your citations and bibliography in your preferred style
e Group or tag references by project, course, or other categories

e Access your library online

e Sync your EndNote library across multiple computers

e Share libraries, and groups of references with other EndNote users
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Groups panel. Shows default groups and any groups or tags you have set up.
Reference List panel. Shows all the references in the chosen group. Display fields can be personalised under Edit/Preferences.

Summary and preview panel. Use the Edit tab to make changes and corrections The preview shows the reference in the chosen style. This panel can be set to
display horizontally or vertically using the cog icon top right.
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Getting started with EndNote

Download EndNote 21 from the Massey Library website
Go to https://www.massey.ac.nz/study/library/referencing-software-and-tools/download-
and-use-endnote/ and follow the instructions.

Create and save your Library

On a PC, the first time you open EndNote you will see an empty grey screen. On a Mac, only
the software menu bar will be visible.

Choose File > New to create your first library. Use one library only for all your references.
Save your EndNote library to a local drive like your desktop. Do not save to a cloud-
syncing folder such as Dropbox, OneDrive, Box, SugarSync, etc. Cloud-syncing folders
corrupt EndNote libraries over time.

Instead set up an online EndNote account at https://www.myendnoteweb.com. This will
allow you to synchronise your library across different computers, have a back-up in the
cloud, and make your EndNote library accessible everywhere.

Set up sync

Go to Edit > Preferences... > Sync. Enter your online EndNote account credentials and
check Sync Automatically is ticked. Click OK.

The online version has less functionality so we recommend working mostly with the desktop
version when exporting references or working with Cite While You Write.

Backing Up Your Library

We do recommend you do manual backups of your Library as well.

EndNote allows you to save your complete Library to a single compressed file (.enlx) which
includes the Library (.enl file) along with its accompanying data folder (.data). Saving this

way minimises the danger of losing your PDF links and other problems.

To save a compressed Library file:

1. Go to File/Compressed Library.

2. Select what you want to save (the default saves the whole library) and click Next.

3. Choose where you want to save it to.

Massey University Library EndNote Guide February 2024 4
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Clicking on the .enlx file will open EndNote and recreate the .enl library file and .Data folder.

Adding references to your library

Import references from a database

Online databases allow you to export references to your EndNote Library, one by one orin a
batch.

Records will initially appear in an Imported Reference group. This is useful for correcting
errors and adding full-text.

The quality of the imported results varies between databases. You will need to check the
references in EndNote, and you may need to edit them. Look out for:

e data appearing in incorrect fields
e incorrect formatting of the title field (e.g. capitalisation)
e incorrect reference type selected
e unwanted information displayed

OWLL shows customised examples of APA, Chicago, and MLA references and in-text
citations for you to compare at

e http://owll.massey.ac.nz/referencing/apa-interactive.php

e https://owll.massey.ac.nz/referencing/chicago-interactive.php

e https://owll.massey.ac.nz/referencing/mla-interactive.php

Internet browser compatibility
Mozilla Firefox performs best, followed by Google Chrome or Edge. You may be unable to
direct export using Safari or other browsers.

The file with the exported references may automatically open with EndNote. Or it may go
into your downloads and you will need to open it from there. The file will have the

extension .ris.

Set EndNote to always open .ris files

In Windows
1. In your downloads, right-click on the .ris file.
Select Open with.
Click on Choose another app.
Select EndNote.
Click on More apps if you cannot see EndNote in Step 4.

o v A W

Check the box of Always use this app to open .ris file.
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7. Click on OK.

In Macs:

1. In your downloads, right-click on the .ris file..
2. Select Get Info.

3. Select EndNote 21. If you cannot see EndNote 21, click on Other..., browse for
EndNote 21 in the Applications folder.

4. Click on Change All...

Mac users

When following the instructions below the EndNote Library may not open automatically.
You may instead be prompted to select an application and/or the relevant Endnote Library.

Discover / EBSCOhost Databases

New Search  Subject Guides.  Atticle Natabases

Toey s
u Searchng Mossey University
L et oy cotectons « g
MASSEY — P—
“  Refine Results 1 - 50 of 533,589 Holmancew  Page Opicns = | (2% Share =

1. Moving library collections [electronic resource] : a management handbook / Elizabeth Chamberiain Habich
foreword by Lee B. Brawner

Ey Hanion, E12a06th CRamuenain, YWastpor Conn, - Greanwsad Fracs, 1998 1 0ANG FSOURH D, 344 pages): USIAons Langusgs: ERplish, Daeabase: MASSEY
LINVERSITY
abjects: Lni ey crsing, Libeary maving - United Staes

Ebooks ¢n EBSCOADSE Academic o

scion. Cick hers toview 8200k

2 Selecting materials for library collections / Audrey Fenner, editor

EBinahamion. Y : Haworlh Informaton Fress, c2004 1, 271 p. : 22 0T Languags: Englisn, Dalanase: MASSEY UNVERSITY's Catsiag
B ublects: Callection ceveiopment (Libraries); Libraries — Spec:a colisctions; 0ok sslection; Selechicn of ranooci matsiials; Azzdemic ibraries — Collsction
g davelopment

o (| (2

1. Click the folder icon next to the record you want to reference, or Share to add all the

results from a page.

2. Find these saved results in Folders.

Article Databases  Library Home

Articles.

14z0te &
Page.

[ Select/geseiectsa [ Delete fems

brary collections / Audrey Fenner, editor

3. To export individual references select the checkbox. Do nothing to export all.
4. Export references to EndNote
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5. On next screen, Save in RIS format. EndNote will open with your references, or you
may need to open the file from your downloads.

Searching using EndNote’s Online Search
EndNote’s Online search import records directly from library catalogues and other sources.

Massey Library generally recommends exporting from databases instead, but it can be used

to search Massey's book collection.

1. Under Online Search, select Massey Book Search.
2. Enter your search. Keep your search results small with distinctive keywords.
3. Tick the boxes next to the records you want to keep.

4. Use the plus icon to add the records to your Library.

Scopus

On the results list, there is a tick box next to each record.
1. Tick the ones you want and then click on Export at the top of the result list.
2. Click on RIS format (eg: EndNote, Reference Manager)

3. From the boxes below select the information you want to export. Abstract &

References is useful.

4. Click Export.

Google Scholar

Google Scholar records will not contain any abstracts or keywords, as Google Scholar

exports only citations.

1. In Google Scholar, click on the Menu icon on the top left of the Scholar homepage.
2. Choose settings.
3. From the Bibliography Manager section, select Show links to import citations into,

and pick EndNote from the drop-down box. Click on Save.
4. Import into EndNote links will now appear for each result.

To export multiple records
1. Sign into Google.

2. Save references to ‘My Library’ by clicking the star icon under the search result.
Massey University Library EndNote Guide February 2024 7



3. Access the saved references by clicking “My Library’ located at the top right of the
screen.

4. Select all or some of the references and export.

PubMed
1. On the results page, tick the records you want to export.

2. Click on Send To at the top of the results list.
3. Select Citation Manager from the menu.
4

. Click on Create File to send to EndNote.

SciFinder-N
(i.e.: Chemical Abstracts, MEDLINE)

When you have a list of references in SciFinder-N:

1. Select the items you want by clicking the boxes. Selecting nothing will download up
to the first 1000 results.

2. Click on the download icon on the top right and select Citations (.ris)

NOTE: These two databases may bring in abbreviated journal titles. A fix for journal title
abbreviations is at:
https://support.clarivate.com/Endnote/s/article/EndNote-Generate-full-or-
abbreviated-journal-names?language=en US.

ProQuest Databases
(e.g. ARTbibliographies Modern, Design & Applied Arts Index, GeoRef, Linguistics & Language

Behavior Abstracts , Proquest Dissertations, Social Services Abstracts, Sociological Abstracts,

etc)

1. Tick the records you want to save.
2. Click Save and choose RIS (works with EndNote, Civati, etc)

3. Confirm the options in the box that appears and click Continue.

Exporting websites from Google or other search engines

It's not possible to export directly from Google, but many can be exported using zbib.org.

Massey University Library EndNote Guide February 2024 8
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1. Go to zbib.org, paste in the webpage URL and click Cite.

2. Click on the drop-down menu next to Copy to Clipboard and choose Download
RIS.

3. Double click the downloaded file.

Import existing full text PDFs from your computer.

EndNote can extract the information it needs from many PDFs if they come from publishers’
websites. You can also import stored PDFs into your EndNote Library.

In EndNote, go to File >Import

>File to choose a single PDF, or

>Folder to choose a folder of PDFs. You can choose to put them in a new Group.
Change the drop-down from ‘Import All’ to ‘Discard Duplicates’

EILI IS, el P e SAEL L AL S LA 1 e EXELT T )

yc ;
res | Arti

narg al Arti
nd Import Folder: | Choose. .. al ﬂtl'tf
aue al Arti
iou []indude files in subfolders Il Arti
teac [Jcreate a Group Set for this import al Arti
teac al Arti
tead  Import Option: FDF | el Arti
15H ; ; al Arti
15H Duplicates: Discard Duplicates ¥ BiAr
ng t | al Arti
“th Import Cance ) Arti

IS ceraereid| At
“ruit: & Collaborati... Collection Man... 1971272017 Journal Arti

If a resulting record has no information other than the filename as the title, the PDF didn't
have extractable information. In this case we recommend deleting the record, exporting the

reference from a database, and manually attaching the PDF.

Manually add references to your library

If you can’t import a reference you can add it manually. Use or References>New

Reference or Ctrl+N.

1. From the reference type menu, select the reference type. The default is Journal
Article.

2. Type in the key information needed to create a reference and any other information
you want to add at this point e.g. tags
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3. Click Save.

<& References Groups Tags Library Tools Window Help

B Edit PDF Edit & PDF

B/ UX X Q

Compare versions ‘ ‘ Save

Tags | Manage tags

Reference Type Journal Article >

Author

Year

Title

Journal

Volume
Part/Supplement
Issue

Paaes @

Tips for adding or editing references:

- Punctuation
Apart from the cases below, do not add extra punctuation or text styles to the
reference information e.g. bold, italics. EndNote will add punctuation and formatting if

it is required by your selected style.
- Authors

Author names can be entered First Middle Last or Last, First Middle

(e.g. Carol Margaret Jacobs or Jacobs, Carol Margaret).

- Multiple Authors/Editors
Each individual author must be entered on a separate line (press Enter to get a new
line).

- Organisational Authors

Enter with a comma at the end e.g. World Health Organisation,

- Autocomplete
As you enter author names, titles, and keywords EndNote will supply possible words
based on previous entries. New entries in these fields will initially appear in red font.

You can select the supplied word by pressing Enter or Tab.

- Titles

Enter these in the correct case for your bibliographic style e.g.: Sentence case for
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article or book titles; or Title Case for journal titles. Check a style manual if you are

unsure. To Change Case select the text in the Edit view and go to Edit/Change Case

- Notes and/or Research Notes
These searchable fields can be used to add your own comments to the reference. They
will not appear in your bibliography.
- Record Numbers
As you enter references into your EndNote Library each record is allocated a Record
Number. This number does not change even if previous record numbers are deleted.
Tags

You may want to add Tags to a reference. You have full control over what Tags you
choose and which references they are added to.

Linking PDFs to references

Find Full text PDFs for references
EndNote will search online for Full text PDFs to attach to references. Select the reference(s)

and click the Find Full Text icon @ or right-click > Find Full Text. A Find Full Text will
appear in the Groups panel showing progress.

The Full text may be available even if not picked up this way. Check by right-clicking on a
reference a reference and selecting OpenURL Link (or OpenURL). See if you can navigate
to the PDF. If so, save it to your desktop and link it manually.

Manually linking a PDF file to a reference
To add a PDF from your computer to an existing reference in your library, either
1. drag and drop the PDF file onto the reference in EndNote, OR

2. click on Attach file in the Summary view and navigate to the saved PDF.
Files can be deleted from your computer once in your EndNote Library.

Removing a PDF from an EndNote Reference
Highlight the reference in your EndNote Library. Use the drop-down menu on the PDF's
label and choose Delete.

Massey University Library EndNote Guide February 2024 11



Bl Denise ..., 2016 #711 Summary Edit X

Denise Troll-2016.pdf  ~

+ Attach file

ORCID @ CMU: Successes and Failures

. Denise Troll

Journal of eScience Librarianship 2016 Issue 2 Pages
1. e1083

Cite While You Write (CWYW) with Microsoft Word

Word can import references from EndNote into documents to create in-text citations and
build your reference list. The commands below are all in the EndNote tab that will appear in
Word once EndNote is installed.

File Home Insert Draw Design Layout References Mailings Review View Zotero Help EndNote21 Pi
[T EN Go to EndNote Style: APA 6th v in- Categorize References v Export to EndNote v o
o @‘ Edit & Manage Citation(s) LE,' Update Citations and Bibliography Instant Formatting is On v ﬂﬂ Manuscript Matcher elp
Citation ~ L:'g, Edit Library Reference(s) R Convert Citations and Bibliography ~ :—E Preferences
Citations EBibliography [ Tools

Inserting Citations
You can either insert an already selected citation or search for a citation within Word.

Inserting a selected citation

Place your cursor in the Word document where you want the citation to appear. In EndNote
select the relevant reference (or select multiple by holding down Ctrl). In Word’s EndNote
tab click Insert Citation/Insert Selected Citations. In your EndNote library you can use the

icon.

Searching for a citation
In Word’s EndNote tab click Insert Citation/Insert Citation....

You can search by any keyword or author name.
Highlight the citations you want and click Insert.

Editing and Deleting in-text citations
Sometimes you need to insert page numbers for direct quotations, exclude the author or
year from the display, or add prefix or suffix comments.

To edit or delete an in-text citation use the EndNote ‘Edit & Manage Citation(s)’ tool in
Word.
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In Word, place your cursor on the citation you want to edit.
Click Edit & Manage Citation(s)

To edit

Check the correct citation is highlighted, add page number(s) or select other options as
desired. Click OK

TIP:

Use ‘exclude author’ or ‘display as author (year)’ when you want the author’s name outside
brackets e.g. Hill (2012) found that people had difficulty...

To delete

Check the correct citation is highlighted, Click Edit Reference drop-down menu, then
Remove Citation

EndNote 21 Edit & Manage Citations X

~

Citation Count  Library

(Digital business and optimizing operating strategies, 2024)

- . , 2024 #2292 Professional reading Edit Reference | ~ t

(The impact factor, 2007)

, 2007 #842 1 Professional reading Edit Reference | »
(Human resource management, 2022)

, 2022 #2296 1 Professional reading Edit Reference | »

Edit Citation | Reference I

Formatting: Default v
Prefix:
Suffix:
Pages:
Tools » Cancel Help

Totals: 3 Citation Groups, 3 Citations, 3 References

Deleting or Moving Multiple References

In Word, highlight the text you wish to delete or move (or select nothing to do the whole
document) and then:

Unformat the citations by selecting Convert Citations and Bibliography/Convert to
Unformatted Citations. This reveals the EndNote code to ensure you move or delete
everything. Delete or move the entire block of text (including the citations).

Click on Update Citations and Bibliography to reformat your bibliography.
Massey University Library EndNote Guide February 2024 13
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2l

Citations Bibliography Tools

These findings have been confirmed elsewhere HFrench, 2019 #712}

Working in Unformatted Mode

Working in unformatted mode is also useful when working in a very long document such as
a thesis. By default, EndNote is set to allow instant formatting which updates the entire
document when a new citation is added. If this is becoming a slow process, turn Instant
Formatting to Off.

Changing the Formatting of Your Bibliography
1. Click the Configure Bibliography box (bottom right of the ‘Bibliography’ section - see

above)
2. Select the relevant tab and make changes as appropriate:

Format bibliography - this allows you to change the document being formatted and

bibliographic style selected.
Layout —lets you give your bibliography a title; change the font, line spacing etc.

Click OK when finished.

Set field shading in Word
This function shades your EndNote citations to prevent accidental deletion. The shading will not

print.

purity each). Each method was derived by evaluating combinations of three
sporulation conditions, including freeze drying of inocula, heat shock
treatment of cultures, and subsequent incubation at suboptimal temperatures
that yielded the highest percentage of sporulation (Bricker & Tollison, 2011).
Pure spore suspensions were characterized in terms of dipicolinic acid
content, culturability, decimal reduction time (D) value for heat inactivation
(100 degrees C) and hydrophaobicity.

Bricker, J., & Tollison, S. (2011). Comparison of motivational interviewing with
acceptance and commitment therapy: a conceptual and clinical review.
Behavioural and Cognitive Psychotherapy, 39(5), 541-559. doi:
10.1017/51352465810000901

In Word go to File/Options/Advanced. Scroll to Show document content, and set Field
shading to Always.
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Word Options

General .
Properties follow chart data point \2/

Display
' Show document content
Proofing
Save Show background colors and images in Print Layout view
Language Show text wrapped within the document window
o Show picture placeholders ®
Accessibility
Show drawings and text boxes on screen
Advanced Show bookmarks

Customize Ribbon Show text boundaries
Show crop marks
Quick Access Toolbar
Show field codes instead of their values

Addins Field shading: |Aways |~
Trust Center Use draft font in Draft and Outline views

Font Substitution...

Expand all headings when opening a document O]

Groups and Tags

To help organise your Library, you can create Groups, up to 5000 of them. EndNote also has
some default groups, both temporary and permanent. All groups appear in the Groups
pane on the left. Tags work in a similar way to user created groups and you will also see the
associated colour tag

User Created Groups
Use the Groups menu to create and manage your groups.

1. Having created a Group from the menu, add references by clicking and dragging
them into the group from the main window. References in a group remain in the All
References Group.

2. Smart Groups use keyword(s) to match references in your library. As more
references are added to your library the Smart Groups automatically update. When
you click Create Smart Group the following form pops up. When created it will pull
any reference that match the word(s) in the Any Field — Contains boxes. In this case it
is tuatara.

Smart Group x

Smart Group Name:|tuatara

| Any Field | | Contains v | |tuatara| I
| And | | Any Field | | Contains | | |
| And v | | Any Field | | Contains v | | |

Options ~ Cancel
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3. Individual groups can be placed into Group Sets for easier management. Click Create
Group Set, name it, and drag the groups you want into it.

Default Permanent Groups
1. All References
Click to view every reference in the current Library, including references in other
groups.

2. Trash
To move references to the Trash select them and press Delete.

Default Temporary Groups
1. Duplicate References
Displays the results of duplicate detection in an EndNote library. These can be
searched for using Library/Find duplicates for any group. EndNote will prompt you
to select which record to Keep. If you do not have time to go through all the
duplicates, click Cancel if you want the default selections kept (the latest record
added). Drag the highlighted references to Trash.

2. Find Full Text
Displays the last group of references for which EndNote inserted either the full text
file or a URL - or has not found. When you close the library, this group is deleted.

3. Imported References
Displays the last group of references imported into the library. When you close the
library, the group is deleted.

4. Search Results
Displays the most recent search results. When you close the library, the group is
deleted.

Referencing Styles
EndNote comes with around 500 of the most popular referencing styles preinstalled. A
drop-down box on the Summary view shows the referencing style being used.

The drop-down menu has several common styles. If the one you need isn't showing:
1. Click on Select another style... from the drop-down box.
2. Browse through the EndNote Styles window or use Find by to search by subject.

Click on the Style Info/Preview button to toggle between an explanation and a preview of

a style.

3. Highlight the style you want and select Choose.
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A further 6,000+ styles are available from the Endnote website at

http://endnote.com/downloads/styles.

Using EndNote Web

Working in Word Online and Google Docs
With the new EndNote Web introduced with EndNote 21, a CWYW add-on is available for
both Word Online and Google Docs.

If you are collaborating with others, we recommend working with the same shared library or
group.

Word Online
1. In Word Online, go to File/Get Add ons to get the EndNote 21 Cite While You Write
extension. When set up it will appear on the right of your document when you are in
the References view.

File  Home Insert Layout References Review View Help [ Comments  *As Catchup (7 Editing v

[) Table of Contents v ab Insert Footnote I} Insert Endnote D Search  *8~ Acronyms @ EndNote

Cite While You Write X

Header ‘

My references Manage citations

Many theses will have some visual content{Kroll, Susan, 2010; Nancy Kim, Phillips, 2011}: a diagram > Citation builder @
expressing a model you're using; a picture of a lifeform you're researching, an art work that you're

analysing, old advertising or photos of life in the past. Q_ Search

Unlless you drew the diagram, took the photo, or created the artwork, you need to get the
permission of the person who owns the Copyright (probably the creatcr)\ To copy a whole work, All References v
acknowledgement isn't enough — you need explicit permission. This can feel a bit strange at first:

Nancy Kim, Phillips

after all, that diagram takes up less than half a page in a 20 page article! That painting by Robin A
White is just there on the Te Papa website! Your uncle took that photo of the 2018 Rural Games in ) -
The impact factor of scientific and
Palmerston North! You still need permission because you are repraducing the entire work to the U ol “) ¢ o .
. scholarly journals : its use and misuse i..
public.

Anon]

Learning objects as tools for teaching
information literacy online: A survey of...
Mestre, Lori S etal

[J Do natural language search engines
really understand what users want?A ...

Harir, Nadjla

[ Are we there yet? Do we have the staff
we need to meet the needs of new ..

Insert Citation Update Citations

2. When entered, in-text citations appear in unformatted mode. Click Update Citations
to format them. You will need to open the document in the desktop app to edit in-
text citations (add page numbers, change how they display).

v

3. To remove a citation, click within it and go to Manage citations. Your citation should
be ticked: click Remove Citation.

4. You can change the referencing style from the ellipsis ... next to Manage citations.

Google Docs
1. In Google Docs, go to Extensions/Add ons to get the EndNote 21 Cite While You
Write extension. When set up it will appear on the right of your document when you
are in the References view. You will need to re-open it from Extensions when you
go into the document again.

Massey University Library EndNote Guide February 2024 17


http://endnote.com/downloads/styles

Untitled document % B & O] x ~ @ share ~ ﬁ,

File Edit View Insert Format Tools Extensions Help
Q 6 ¢ & A § 100% - Normaltext ~ | Arial v =[]+ B I VUAZ2 o@BE ; 2~ 5
: \ e e FIPAPE ORI (PSP, o I PO LS i AP EF PR AP AT ST My references Manage citations &
—
" Undo
Many theses will have some visual content (Bathorpe & Dominion Post, 2012): a diagram Search references Q

Outline expressing a model you're using; a picture ¢ © Hhttpsiiweb.endnote.comi.. @ £ B

you're gpalysing, old advertising or photos ¢ All References ~ Title - b
Unless you drew the diagram, took the photo, or created the artwork, you need to get the

permission of the person who owns the Copyright (probably the creator) . To copy a whole work, [J Why OpenURL?
acknowledgement isn't enough ~ you need explicit permission (Bagchi et al., 2017). This can Ann Apps et al, 2006

feel a bit strange at first: after all, that diagram takes up less than half a page in a 20 page

article! That painting by Robin White Is just there on the Te Papa website! Your uncle took that [[] Arewe there yet? Do we have
photo of the 2018 Rural Games in Palmerston North! You still need permission because you are the staff we need to meet the...
reproducing the entire work to the public, Bathorpe, Gillian et al, 2012

O “But | Want a Real Book": An
Investigation of...
Referencs list Gregory, Cynthia L., 2008
Bagchi, R., Block, L., Hamilton, R. W., & Ozanne, J. L. (2017). A field guide for the review O ‘The kids are alert: Generation
process: Writing and responding to peer reviews [Article]. Journal of Consumer Y responses to employer use...
Research , 43 (5), 860-872. https:/doi.org/10,1093/jcr/y Hurrell, Scott A. et al, 2017

D 10 point guide to dodging
oublishina pitfalls

Bathorpe, G., & Dominion Post. (2012). http://docs.lib.purdue.edu/iatul/2012

Update Citations ¢

1. When entered, in-text citations appear in unformatted mode. Click Update Citations
to format them. You will need to download the document and edit in Word to edit
in-text citations (add page numbers, change how they display).

2. To remove a citation, click within it and go to Manage citations. From the citations
listed click the pencil icon, and a trashcan icon will appear at the bottom. Click this to
remove the citation.

3. You can change the referencing style from the three dots next to Manage citations.

Sharing EndNote libraries and groups

In EndNote desktop, go to File/Share... and enter in the email addresses of the people you
want to share your library with. The email addresses must be the ones they used to create
EndNote Web accounts. You can assign them Read Only, or Read and Write Access.

To share a Group, right click on the Group’s name and choose Share Group... Smart
Groups can't be shared.

Further help

e Watch our QuickStart Video tutorial
e Reqister for an Endnote class (face-to-face or online)
e Check our Massey EndNote FAQs

Contact a librarian or book an appointment https://massey.libcal.com/appointments/
Phone 0800 468 542
Email library@massey.ac.nz

Massey University Library EndNote Guide February 2024 18


https://connect.massey.ac.nz/endnotequickstart/
https://massey.libcal.com/calendar/library-events?cid=2383&t=d&d=0000-00-00&cal=2383&ct=5969&inc=0
https://massey.libanswers.com/search/?t=0&g=3443&topics=EndNote&adv=1
https://massey.libcal.com/appointments/
mailto:library@massey.ac.nz

